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What is Whale Express?
Whale Express is an example of an "application specific" scripting 

language.    Whale Express is custom designed to work with America Online 
for Windows.    While a number of scripting languages already exist in the 
Windows market, most are complex and require programming experience on 
the part of the user.    Whale Express is designed using K.I.S.S.(Keep It Simple
Stupid) technology.    While future versions may include complex 
programming structures, this version uses knowledge of WAOL to include 
conditional information within Whale Express.

The free trial size version of Whale Express is available for downloading
on America Online.    The only charge is the short time required for 
downloading. This free version of Whale Express is fully functional but is 
limited to 10 commands per script.        If you find yourself using Whale 
Express often, you'll probably wish to order the pro-version for a small fee.    
Ordering is simple and an order form is available by clicking here.

Distribution of Whale Express is done strictly through America Online 
via electronic mail.    There are a number of advantages to ordering Whale 
Express and being a registered user.    Most importantly, you'll be eligible for 
support via electronic mail on America Online.    Tartan Software will also be 
sure you receive any maintenance and incremental feature releases of Whale
Express.    Be sure to include your screen name when ordering. 



Getting Started

First let me assure you that you don't have to be a computer programmer to 
use Whale Express.    It's easy to create straight forward, easy to use macro 
files which will save you from time while using America Online.

Probably the best way to understand how to use Whale Express is to review 
some of the sample WEX files included with the package.    Like most 
Windows applications, using the Open item on the File menu will allow you 
to view and edit Whale Express script files.    This functionality is the same as 
you'd experience using the Windows NotePad or Write application.
.
Reviewing these sample files will demonstrate the more popular Whale 
Express commands.    For more info on each command, use the "Search for 
Help On..." under the Help menu.

Creating your own scripts can be done by modifying the sample scripts or 
using the New menu item under the File menu.    Scripts should be saved in 
the same directory as the Whale Express application, WHALEX.EXE.

One Addition to the File menu is  Run....    This is the primary method of 
executing your scripts.    Run will bring up the standard Windows open file 
dialog which will allow you to select which script file you wish to run.    Just 
select the filename you wish you run and select OK.    If your script runs 
successfully, it will be available under the Express menu for quick access 
the next time you want to run it.

Some scripts are useful in that you can use them to sign you on to America 
Online, perform requested functions, and sign off.    Other scripts are run 
when you're already online. For example, the forward.wex script is only used 
when you've recently read a mail message. Feel free to try running the 
sample script files provided.    They've all be been tested pretty extensively 
and won't do you any harm.

RUNNING A WHALE EXPRESS(WEX) FILE

Under the File menu, you'll find the item,    "Run".    Selecting Run bring up 
the standard File open dialog which allows you to select the Whalex macro 
file you want to execute.    Just find the WEX file you want to run, and select 
the OK button.

Anytime you run a WEX file successfully, the name of the file will be added to
the Express menu.    This allows you quick access to those macros which you 



use most often.    Up to 10 WEX files will be stored here. 

The F3 key can be used to abort a script in progress.

Helpful Tips
To use the SignOn command, auto passwords must be enabled.    To enable 
"Stored Passwords" in America Online, use CTRL= while in the America 
Online application.    Select the Password icon and enter your password. 

The F3 key can be used to abort a script in progress.

When you successfully run a script, the script name will than be available 
under the Express menu.    The last 10 successful scripts will be available 
from this menu.



Sample Scripts
AMER.WEX
This is a simple script which takes the user to the StockLink area on AOL.    
AMER is the stock symbol for America Online Inc.    This provide a quick way 
to check the price of America Online.    Change this script so you can quickly 
check your own favorite stock.

FORWARD.WEX
Instead of using the Reply button when reading Email.    This is a sample of    
a script you could use to forward mail back to the original sender and than 
include your comments.    This is handy when you might need to remind the 
sender what you're replying too.    For this script to work, you should run it 
right after reading a piece of mail.

GETMAIL.WEX
This file is an example of how you can use Whale Express to SignOn,    Read 
all your mail, and sign off again.    You'll notice that the NewScreenName 
command allows you to access multiple accounts from a single script.    Just 
remove the rem statements from this script.

GETNEWS.WEX
This script is handy for you news hounds who'd like to search the America 
Online news database for articles on specific topics.    This example will find 
and capture news articles on the topics Microsoft,    and also America Online.

MAILFORM.WEX
This is a good example of using SelectEdit and SetText    to fill in online form 
such as Email.    This sample will send a friendly note to Tartan Software 
support.

MAILTEXT.WEX
This is a short and simple file which demonstrates the SendMail command. 
You'll also want to review the file MAILTEST.TXT which is formatted with all 
appropriate information needed to send Email on America Online.

NEWWIN.WEX
This powerful script demonstrates using Whale Express to find recent 
uploads in America Onlines File Search.    In this case,    all files in the 
Windows libraries uploaded in the past week at marked for Download Later.    
This is a good example of the powerful ReadList command.    Adding the 
Download command will cause all files in the Download Manager to be 
downloaded before exiting your online session.    You will need to change your
download options on America Online(CTRL=) so that you no longer confirm 
additions to your download manager.



PCDEV.WEX
This script shows you how you can sign on America Online, and go directly to
your destination.    In this case, we take you to the PC Development forum, 
and directly into the Development conference room.    This even 
demonstrates the SendText command for chatting in interactive rooms.

ROOMS.WEX
A little known feature allows members to list all active discussions in 
conference rooms.    These rooms allow up to 48 users and often have useful 
topics.    This script keywords to the "Tonight in the Forum" area and selects 
the first menu item which is "Check for Live Discussions"



Whale Express Files

You'll notice that all Whalex scripts have the suffix,    .WEX.    This is used to 
indicate a Whale Express script, even though a WEX file is the same as an 
ASCII text file.    Our program provides a full Windows style editor to view and
edit your work.    You're not required to use this editor to create or edit 
scripts.    Since these files are ASCII text,    most any text editor will do.    If 
you're more comfortable using your favorite DOS editor, or even Windows 
Notepad, you'll be fine.

A WEX file is made up on a sequence of instructions.    Each line of the file 
contains a new instruction.    Each instruction is processed one at a time, 
starting with the first line.    Each one of these instruction lines contains a two
parts,      the command and the data.    No special characters are required.    
The command and data are separated by one or more spaces.

The syntax of a Whale Express instruction is straight forward and easy.    
Many of the internally built application specific commands provide the error 
checking and conditional responses needed for useful scripting.    This allows 
scripts to be short and easy with as few commands as necessary.    The 
following is the simple syntax of a Whale Express instruction:

Command Data

* There must be at least one space between the Command and its data.
* Only one instruction per line.      
* Data strings DO NOT require any quotes for delimiters.    If you include 

quotes, they will be taken literally as quotes.
* The Whale command processor is case insensitive so you don't have to 

worry if your capitalization matches the examples in this document.
* Many data fields have default values so data is option or not required.
* In many cases, the full text is not required in the data field. Whale Express 

allows partial text matches.



Alphabetic List of Commands
AddText
Bitmap
Begin
Call
CloseChatLog
CloseLog
CloseWindow
Cut
Copy
Download
Error
Exec
Exit
InstantMessage
Keyword
listEnd
listMatch
listNext
listSelect
listStart
Menu
Message
Movie
NewScreenName
OnError
OpenChatLog
OpenLog
Pause
Paste
PasteFile
PlayWav
Rem
Read
ReadList
Repeat
Quit
SelectButton



SelectEdit
SelectIcon
SelectList
SendMail
SendText
SetText
SignOn



Commmands Listed by Groups
WAOL Navigation

Signon
NewScreenName
Exit
Menu
Keyword
Upload

Controls
CloseWindow
SelectButton
SelectEdit
SelectIcon
SelectList
ReadList

Text
SendText
SetText
AddText
Cut
Copy
Paste
PasteFile
SendMail

File Management
OpenLog
OpenChatLog
CloseLog
CloseChatLog
Exec

Misc Features
Begin/Repeat
Rem
Call
OnError
Pause
Quit



Multimedia
Message
Bitmap
PlayWav
Movie

Command Variables
Read
Delay
Error
listStart
listEnd
listNext
listSelect
listMatch



SignOn

SignOn name

This command initiates the signon process to America Online, including the
selection of screen name and dialing America Online. The name should be 
the screen name or Email address you wish to use.    If no name is    
provided, the current screen name will be chosen.    If you are already 
signed on to America Online, this command is ignored.

NOTE:    Signon requires that stored-passwords are enabled.    You 
can set this feature using CTRL = for the America Online options 
dialog.



NewScreenName

NewScreenName 1..5

This is a very useful command which combines all the commands needed 
to allow you to sign off, and    back on-line using a new screen name.    This 
command is so useful that it's also available from the Express menu for 
easy access.

NOTE:    Signon requires that auto-password is enabled.    You can 
set this feature using CTRL = for the America Online options 
dialog.



Exit

Exit
When completing your on-line duties, Exit will sign you off America Online, 
and will exit the America Online program.    You may notice a short pause 
while Whale checks if you have files in your Download Manager. If the 
Download Manager has files, they will not be downloaded using this 
command.    You can use the Download command if you'd like files 
downloaded when you exit.



Quit

Quit
This command provides a way for you to quit the Whale Express program 
from within a script.    This is not the same as the Exit command which will 
quit the Windows America Online software.    



Exec

Exec <program name>

This command allows you to run other Windows programs from within a 
Whale Express script.    This is handy for running other WAOL Add-On 
programs which you might enjoy as much as Whale Express.    You should 
include the full path name of your program, unless the program exists in one 
of your path directories.



Download

Download

This command is the proper way to exit the system and download all the files
in the download manager before exiting.    Download should be the last item 
in a script file.

All files found in your Download Manager will be downloaded, and Whale 
Express will exit America Online.



Keyword
Keyword keyword

Just like the CTRL-K for doing Keywords on-line, this command will take you 
to the department on-line which is specified in the data field.    For 
Compuserve users, this is the same as using    GO.     For Prodigy users this 
would be the same as a JUMP.

Example:

Keyword TITF
SelectList 1

TITF is the short keyword for "Tonight in the Forums".    By selecting the first
list item, it will currently display a list of open conference rooms.



Menu
Menu Menu Text

Menu allows Whale Express to select a menu item just as if you pulled 
down a menu and selected an item.    You won't have to include all the text 
found in the WAOL menu, but you'll need to provide enough so there's no 
confusion with other menu items.

Example:

Menu          Lobby
SelectIcon          List
SelectButton          Private
SelectEdit          1
SetText          Whale Express
SelectButton          Go



InstantMessage

InstantMessage off | on

This is handy little-known feature of America Online.    This command will tell 
America Online to hold sending you Instant Messages and Promotional 
banners.    This command can be used to make sure that your automated 
operation isn't disrupted by a well meaning friend.    The data tells whether 
you want messages on or off.

Example:

Signon          1
InstantMessage          off
Keyword          StockLink
SelectEdit          1
SetText          AMER
SelectButton          Get

While turning off Instant Message isn't required for using Whale Express, it 
will prevent people from thinking you might be ignoring them.



SendText
SendText Text message

This command allows you to broadcast text in a conference or room in 
People Connection.    This command is intended for people who run 
conferences or teach classes on-line where text can be prepared ahead of 
time.    Data must be less than 93 characters.

NOTE:    Misuse of this command in such a way to be disturbing to other 
America Online members can be a violation of terms of service.    Loss of 
your America Online account could result.

Example:

SendText          I'd like to thank you all for coming tonight
Pause          4
SendText          Next weeks topic will be Windows
Pause          4
SendText          Goodnight

You'll notice the pause statements between multiple SendText statements.   
These are very important in making your text readable by both new users 
and old-timers.



OpenLog

OpenLog Filename

This command uses the Logging feature of America Online which allows 
you to maintain a file which will capture all the message read while on-line. 
The filename parameter should be any normal DOS file or path name.    If 
the file already exists, the log file will be opened in Append mode and will 
not delete information previously in the file.

Example:

Signon          1
OpenLog          c:\mail.txt
Menu          Read
ReadList
CloseLog
Exit



OpenChatLog

OpenChatLog Filename

This command uses the Chat Logging feature of America Online which 
allows you to maintain a file which will capture all the conversations in a 
conference room or in People Connection.    The filename parameter should 
be any normal DOS file or path name.    If the file already exists, the log file 
will be opened in Append mode and will not delete information previously 
in the file.



CloseLog    / CloseChatLog

CloseLog / CloseChatLog
These two commands are used to close respective logs of the previous 
OpenLog commands. You may Exit America Online without closing the Log 
file, but some data loss may occur.



SendMail

SendMail Mail Filename

SendMail is used to send text files which have been formatted as an off-line
mail file. SendMail allows you to write all your Email off-line with the Whale 
Express editor, and use a Whale Script to automatically send your Email as 
quickly as possible.

The format of an off-line mail message contains all of the information found
in the Mail Compose form Online.    With the exception of the text of the 
message,    Each line of the file contains one item.    Each line can wrap 
within the Whale Express editor, but ends when you press the Enter key

Line 1> TO: information
Line 2> CC: information.    Leave a blank line if no Carbon Copies are to be 
sent.
Line 3>SUBJ: This is required field and must contain the title of your 
message
Line 4>File:    This is also optional, but if you'd like to send a file via Email, 
enter the full path on this line.
Line 5> The text of your message begins here.



Rem

Rem
Like most languages Whale Express allows comments and remarks within a
file.    You can use a Rem statement to add comments to your Whale scripts.



Call

Call Express Script name

This command    allows you to call scripts from within another script.    This 
allows the creation of small reusable scripts which can be called from other
main scripts. 

Example:

Signon 1
Call        C:\whalex\myscript1.wex
Call        C:\whalex\myscript2.wex

Another good use of Call is in conjunction with the OnError command.    This
allows you to execute multiple commands following a script error.

Example

OnError          Call    myerror.wex

Note if your scripts are in the same directory as the Whale Express 
application, you aren't required to use the full path.



OnError

OnError Express command

In the case of a command failure,    the command from the last OnError 
statement is executed. Common examples would allow you to Exit AOL if a 
script failures, or begin other scripts with the Call statement.    Multiple 
OnErrors are allowed within a script, but only the last OnError command 
will be used.



Error        On | Off
Under most cases, your script will fail to continue an error occurs in any of 
the commands.    There may be times when you'll want to continue even if 
are button or icon is not found in previous commands.    You can turn Error 
checking off by using the statement,        Error    Off

Error On    will reset the default error checking condition.



CloseWindow

CloseWindow
The basic command will force the current top most window to close.



Pause

Pause Seconds

This command will create a pause in the Whale script.        The data field is 
the number of seconds you wish to wait before continuing on to the next 
Whale instruction.    A common use for this command is creating a lecture 
in a conference room, a Pause should be used between successive 
SendText to users have time to read your messages.

The number of seconds is options and defaults to the current value of the 
Delay variable.    The default for Delay is 10 seconds.

Example:

SendText          I'd like to thank you all for coming tonight
Pause          4
SendText          Next weeks topic will be Windows
Pause          4
SendText          Goodnight



SelectIcon

SelectIcon Icon label text

Example: SelectIcon    Send

This command will simulate a mouse click on an Icon picture on the current
window.    Whale Express will search for the icon immediately above the 
text you specify.    Partial text matches are allowed and recommended. In 
fact, if icon text is contained on two lines, you should only match with the 
first line.      In cases where multiple icons have the same text, such as 
"Click Here", the first icon found will be selected.    To handle these 
situation, there is an alternate way to select your icon by icon number with 
the use of the # symbol

Example: SelectIcon      #3



SelectButton

SelectButton Button text

Works just like SelectIcon in that it simulates a user pressing or double 
clicking on a button.    This allows you to select any button on the current 
top window.    Partial matches are supported.

NOTE: SelectButton will also work on radio buttons and check boxes.

Example:

Menu          Lobby
SelectIcon          List
SelectButton          Private
SelectEdit          1
SetText          Whale Express
SelectButton          Go



SelectList

SelectList List item 1..n

This command will simulate the user selecting an item in a list box. 
SelectList assumes only one List control is in the current top most AOL 
window.    The first item in the list is considered list item number 1.

Example:

Keyword          TITF
SelectList          1

TITF is the short keyword for "Tonight in the Forums".    By selecting the first
list item, it will currently display a list of open conference rooms.



SelectEdit

SelectEdit Edit field 1..n

This command will set the focus to an edit field    control. This command is 
important for using SetText command and can also be used in setting focus
for the Cut/Copy/Paste/PasteFile commands.    The relative position of the 
edit control is determined by AOL form designers.    Any changes made in 
form definition by AOL programs could affect your scripts.    You might have 
to experiment a little to find the correct field number, but in most cases 
AOL have created fields in a logical order.

Example:

SelectIcon          Forward
SelectEdit          1
SetText          BillP
SelectEdit          4
SetText    ----    Forwarded by Whale Express    ----
SelectIcon          Send

This short script is handy if you'd like to forward mail to another user or 
screen name.    In this case, while reading mail, this script will click on the 
Forward icon bringing up the Forward Mail form SelectEdit is used prior to 
using SetText to fill in the form with the user name BillP



SetText

SetText Text message

This command will enter text into the edit field with the current focus, just 
as if you had typed it in.    Use SelectEdit if needed to set the focus to the 
desired AOL edit field.

Example:

Menu          Compose
SelectEdit          1
SetText          Tartan
SelectEdit          3
SetText          Whale Express test
SelectEdit          4
SetText        Hi!    I'm testing the mailform.wex script
SelectIcon          Send

This example brings up the Email compose form and fills in text based on 
the edit field number.    The edit field numbers are determined by America 
Online forum designers and are subject to change.    In most cases, they 
won't change and field numbers will be created in a logical order.



AddText

AddText Text message

This command will add your text to an edit field with the current focus, just 
as if you had typed it in.    Use SelectEdit if needed to set the focus to the 
desired AOL edit field.

AddText also adds End of Line characters so that multiple AddText 
commands can be used within the same Edit field.    Unlike SetText, this 
command will not replace the text currently in the edit field.

See Also:    SelectEdit, SetText



Cut

Cut Edit field 1..n

This command will select all the text in the edit field specified in the data 
field and delete the text, placing it into the Windows clipboard.    If no data 
field is used, then the field with the current focus is used.    Current focus 
can be set using the SelectEdit command



Copy

Copy Edit field 1..n 
This command will select all the text in the text box and copy it into the 
Windows clipboard.        Copy will allow you to access non-editable text 
messages allowing scripts to copy text from on-line articles and messages. 
It will also act on Edit fields similar to Cut, but will not delete the text from 
the edit field.      Current focus can be set using the SelectEdit command



Paste

Paste Edit field 1..n

This command will copy any text in the Windows clipboard into the 
currently selected Edit field.    You can also set the paste field by using a 
number in the data field.



PasteFile

PasteFile Filename

SelectEdit 2
PasteFile c:\waol\document\help.txt

PasteFile allows you to read a file directly into an America Online edit field.  
Before using PasteFile it might be necessary to use SelectEdit to set the 
typing focus to the edit field you're pasting into.



ReadList

ReadList Express command

ReadList is a powerful command which is used in a variety of places to 
Processing list items.    Use this command when you've reached an area 
online which presents you with a list box, like Mail, or Message boards.    
This command will read each item one at a time.    

The number of items can be set with the Read variable.    In many case , 
before using this command you'll probably wish to use the OpenLog 
command so that text will be saved in    file.

The optional data parameter allows extra processing of each item.    You 
many add any command here which will be executed for each item in the 
list.    An example is the Download Later button while viewing a list of files 
in a library.

Example:
The following script will search for all the files which have been uploaded 
during the pass week and

Keyword File Search
SelectButton Past Week
SelectButton List
ReadList  Download Later

Here the SelectButton command is done after each item is processed 
putting the file into the download managers.    At the end of this script you 
could add the Download command which would exit America Online 
downloading all items in the download manager

ReadList Options:

Under normal circumstances when ReadList processes an item, it will look 
for a valid Next icon which is used in many message boards.    This is 
extremely helpful for reading complete folders.    In some message boards 
however, the messages read with the Next icon are the same as those on 
in the list.    To prevent this redundancy, you can turn the processing of the 
Next icon off with the listNext variable.

ReadList processes the list by selecting each item on the list.    This is the 
same action as a user double clicking.    In some cases you may want to 
process a list by highlighting an item and selecting one of the buttons on 



the current list.    This can be accomplised with the help of the listSelect 
variable

Also See:
listStart, listEnd,listMatch



Message

Message Text Message

This allows some interaction during the script playback and can be helpful 
for OnError situations.    Using this command will create a popup message 
box with the text you specify as the text message.

If you include the following in your script, anytime there is an error you'll 
received a message.

Example:

OnError Message    There has been an error.



PlayWav

PlayWav WAV filename

This feature allows you to add fun sounds to your scripts.

This command will play a    sound "wav" file using the installed Windows 
sound driver.    The wave file name can be the wav name listed in the 
WIN.INI file, or just filename if the wav file is in a directory found in the 
directory Path.      You can also use the full path name of the wav file.
The .WAV suffix is not required.

Example:

PlayWav          c:\sounds\coool.wav

You can also utilize the PlayWav command with the OnError by setting the 
following example.

OnError          PlayWav    c:\sounds\bummer.wav



Bitmap

Bitmap BMP filename

This command will display a bitmap in the center of the screen for the 
default number of seconds or that set by the Delay variable.    This 
command can be used within a script which might be used for applications 
using Express scripts for demos.

Delay          10
Bitmap          c:\windows\tartan.bmp



Movie

Movie AVI filename

Movie          c:\windows\media\earth.avi

This command will center a dialog on the screen and play the Video for 
Windows movie specified by the AVI file name.    It's not necessarily 
something you'll need to automate your America Online scripts, but it does 
provide an easy way to play AVI files.

The Video for Windows runtime package is required for this command.    If 
you require this software contact Tartan Software and it will be sent to you 
free of charge(excluding AOL download costs).



BEGIN/REPEAT
BEGIN/REPEAT number of times

The Begin/Repeat structure allow scripts to repeat a certain number of 
times. 

Example:    Lobby.WEX
OnError    PlavWav    Hello.wav
SelectIcon List
BEGIN
SelectList Lobby
SelectButton No
REPEAT 30

This is an example of wanting to get into a particular room in the People 
Connection area.    This script will bring up the room list and make the 
selection to enter the room named Lobby. In many cases, rooms you want 
to enter are full and you get a message asking if you'd like to enter a 
similiar room. This script will continue to knock on the door of the room    
for 30 times or until it finally likes you enter. When you enter, it won't find 
the No button and the OnError condition will play a wav to let you know.

You could also use BEGIN/REPEAT to look for people online using the Get 
Info menu. Don't forget you can include a Pause in your loops and create 
operations which are performed every minute or so.



Read

Read 1..n

Setting this variable will allow you to set the number of messages read 
when reading the news, message boards or download libraries.    You can 
set and reset Read anywhere in the script, The preference would be to set 
Read directly before calling a function which reads multiple messages.

Example:

Keyword          file search
SelectButton          Past week
SelectButton          Windows
SelectButton          List
read 10
ReadList          SelectButton Download Later

This will tell Whale Express you only wish the first 10 files found to be 
added to your Download Manager.



Delay

Delay 1..n
This variable is used to specify default waiting periods for commands such 
as Bitmap or Pause.    Default value is 10 seconds.

Example

Delay          10



listSelect

listSelect on | off
Example:            listSelect OFF

This command variable allows you tell Whale Express if you want to 
actually select a list item or just highlight it.

Under normal conditions both SelectList and ReadList will act as if you 
double click the mouse on the list item.    By turning listSelect off, you can 
highlight the item you desire, and than select the appropriate action.

Sample Use:

listSelect OFF
SelectList 3
SelectIcon Find Since
SelectEdit 1
SetText 7
SelectIcon Search
listSelect ON
ReadList



listNext

listNext on | off
 

Example:            listNext OFF

Normally, when ReadList processes messages, it will automatically look for 
a valid Next icon.    If found, the Next button is processed.

On some boards the next message can be found in both the list, and 
accessed with a Next button.    This can cause redundant reading of
messages.

Sample Use:

listSelect OFF
ReadList 



listStart

listStart 1..n
Example: listStart    3

Under default conditions ReadList will begin on the first list item and 
process the max items available.    Setting listStart in your script will allow 
you to begin the list processing on the item you need.



listMatch

listMatch text to search on

The ReadList command will use listMatch to decide which items to select.    
Normally, ReadList will select all the items in the list.    With the addition of 
a listMatch instruction, you can tell ReadList to only select those messages 
with particular text in the list item text

The default for listMatch is to read all items. To set listMatch back to it's 
default status use the wildcard character.

listMatch *

At this time no logical operations are supported.    Only single text matches 
are supported. such as AND/OR operations.

Example:

Menu Read New Mail
listMatch Test
ReadList Call  treply.wex

The above sample script which we use here at Tartan Software to 
automatically respond to those mail messages which are send to the Tartan
name from people testing Whale Express.    The script reads all our new 
Email and selects those messages with the text "Mail Test" in the subject 
line.      We've provide you with the TREPLY.WEX below so you'll see the full 
picture.

SelectIcon Reply
SelectEdit 4
PasteFile c:\tartan\treply.txt
SelectIcon Send
SelectButton OK
CloseWindow



listEnd

listEnd 1..n
Example: listEnd    9

Under default conditions ReadList will processe max items available. 
Setting listEnd in your script will allow you to specify the last 
item you need.

Sample Use:

listStart 3
listEnd 9
ReadList



Upload

Upload filename
Note:    Upload will only be available to registered Whale Express users.

The Upload command may only be used when the current America Online 
window is an Upload form. This form is usually in response to selecting the 
Upload icon, or using "SelectIcon Upload".

Before using the Upload command it's appropriate to set the values of the 
various fields.    These values can be set once and used for each upload or 
can be reset before each Upload command.    If no values are set, default 
values will be used.

Subject
Author
Equipment
Needs
Description

Subject      data
This field is required by America Online
Data field is limited to 32 characters

Author    data
Data field is limited to 20 characters

Equipment      data
Data field limited to 32 characters

Needs      data
Data field is limited to 36 characters

Description      filename
This data field should be the name of a description file.    If no file is 
specified default value is used.

Example Upload script

In the following example we have a number of files, all with the same 



Author, Needs and Description.    We set these fields once and then instruct 
Whale Express to upload the file.    After the initial upload, we change the 
Subject line and upload other parts of the program. 

SelectIcon Upload
Subject PAINT: v1.3 Basic Paint Program
Author    My Software Company
Needs    An UnZIPing program
Description    C:\paint\mypaint.txt
Upload c:\paint\mypaint.exe
Subject PAINT: Utility for MyPaint
Upload c:\paint\paint1.dll
Upload c:\paint\paint2.dll
Upload c:\paint\paint3.dll
Upload c:\paint\paint4.dll
CloseWindow



Date, Time, Input
The following special variables can be used in your data parameter to allow you to change the 
value of what is used based on the current date, time or what you type in during the execution of 
the script.

%input 

Will prompt you for variable data to be entered.    Do not use this in any scripts which you run 
unattended.

Example:            SendText    Hi %input,    How the heck are you?

%date 

Will insert the current date into the data.
      

Example:            OpenLog    C:\MAIL\MAIL%date.TXT

The %date is four characters in the format    MMDD

%time 

Will insert the current time into the data

Example: Message      The date is %date, current time is %time

The %time is six characters in the format    HHMMSS



(Print this form)

TARTAN SOFTWARE ORDER FORM

AOL Screen Name ___________________________________________

Name ______________________________________________________

Address ___________________________________________________

City ___________________________ State ______ ZIP _________

Phone (optional) _____________________ Circle: home or work

(New York residents must add appropriate sales tax.)

County______________________________________

Whale Express v2.x ________ $ 39.95
C-Room v2.x ________ $ 19.95
TimeKard v1.x ________ $ 24.95

Tartan Booster
Complete Package ________ $ 69.95 (Save $16.00)

NYS Sales Tax ________ (if New York state resident)

Amount enclosed:    $______________

Please make all checks payable to Tartan Software

Mail to:    Tartan    Software                      
143 Horstman Dr
Scotia, NY    12302




